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Notes
This document was designed to be distributed electronically and then printed on a laser printer on an as-needed basis. For this reason, the fonts and layout of this document have been chosen for optimal printing rather than for optimal viewing on-screen. To review this document on-screen, however, simply increase the magnification using the magnification box at the bottom of the window. For the best results when viewing dialog boxes on-screen, increase the magnification to 200%.
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1

 

Introducing Adobe Premiere 

 

4.2

 

elcome to the Adobe Premiere

 

™

 

 4.2 
program—software that brings the 
world of digital movie making to the 

desktop. With Adobe Premiere, you can record, 
create, and play movies using video, sound, ani-
mations, photographs, drawings, and text. You 
can create Microsoft

 

®

 

 Video for Windows

 

™

 

 or 
QuickTime

 

™

 

 for Windows movies.

You can play Adobe Premiere movies in any 
application that supports either the Video for 
Windows or the QuickTime format, output 
movies to videotape, or use the edited movie to 
create an Edit Decision List (EDL) for online 
editing in a postproduction studio.

 

ABOUT THIS GUIDE

 

Before you begin using Adobe Premiere, be sure 
to read this guide for installation instructions 
and other important information. This guide 
contains the following information:

 

O

 

Instructions for installing the Adobe Premiere 
software

 

O

 

A summary of new features in Adobe 
Premiere 4.2 and 4.0

 

O

 

Tips on improving performance in Adobe 
Premiere

 

O

 

Troubleshooting tips for video capture

 

O

 

Information about the Adobe Type Manager

 

™

 

 
(ATM

 

™

 

) utility

 

Adobe Premiere Getting Started

 

 is for all Adobe 
Premiere users, including users upgrading to 
Adobe Premiere 4.2 and 4.0 from a previous 
version of the program.

 

SYSTEM REQUIREMENTS

 

To use the Adobe Premiere program, you need 
the following hardware and software:

 

O

 

An Intel

 

®

 

 80386- or 80486-based or faster PC; 
an 80486 or Pentium processor is recommended

 

O

 

MS-DOS

 

®

 

 5.0 or later (not required if you 
have Windows 95)

 

O

 

Microsoft Windows

 



 

 3.1, Windows for 
Workgroups 3.11, Windows NT

 

™

 

 3.51, or 
Windows 95

 

O

 

8 megabytes (MB) of RAM (16 MB for 
Windows NT); 16 MB or more is recommended 
for editing full-screen video

 

O

 

100 MB hard drive; 500 MB or more is recom-
mended for editing full-screen video

 

O

 

An 8-bit (256 colors) color display adapter; 
a 16-bit or 24-bit color display adapter is 
recommended

 

O

 

A video digitizing board that produces movies 
in Video for Windows format is recommended 

 

O

 

Video for Windows (version 1.1, not required 
if you have Windows 95). The Video for 
Windows runtime software is included on the 
Deluxe CD-ROM.

 

O

 

QuickTime (version 2.0 or later). The Quick-
Time for Windows program (version 2.1) is 
included on the Deluxe CD-ROM. 

To use the software included on the Adobe 
Premiere Deluxe CD-ROM, you also need a 
CD-ROM drive.

Adobe Premiere performance improves with 
faster versions of the PC, more RAM, and faster 
and larger hard disk drives.

 

W
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THE ADOBE PREMIERE PACKAGE 
CONTENTS

 

The Adobe Premiere package contains the fol-
lowing distribution media and documentation:

 

O

 

The Adobe Premiere Deluxe CD-ROM that 
contains the Adobe Premiere program, 
supporting system software, and additional 
software programs. For a complete description 
of its contents, see the following section.

 

O

 

Adobe Premiere User Guide

 

O

 

Adobe Premiere Getting Started

 

O

 

Adobe Premiere Quick Reference Card

 

O

 

Adobe Premiere registration card

 

THE ADOBE PREMIERE DELUXE CD-ROM

 

The Adobe Premiere Deluxe CD-ROM includes 
the following software:

 

O

 

Adobe Premiere software and support files. 

 

Two 
versions of Adobe Premiere are included on the 
CD-ROM, version 4.0 for use with Windows 3.1 
and Windows for Workgroups 3.11, and version 
4.2 for use with Windows 95 and Windows NT. 
Version 4.2 will not run on Windows 3.1. The 
Deluxe disc also includes the installer software 
program, the Video for Windows runtime soft-
ware, the QuickTime for Windows software, the 
Intel

 

®

 

 Indeo

 

®

 

 Interactive software codec, and a 
number of sample files.

 

O

 

Adobe Type Manager.

 

 The ATM font utility 
gives your applications a smooth, high-quality 
display for Adobe Type 1 fonts. Note that ATM 
does not work with Windows NT.

 

O

 

Adobe Premiere movie tutorials.

 

 These 
QuickTime movies feature expert users of 
Adobe Premiere teaching special techniques and 
introducing new features of Adobe Premiere. 

 

O

 

Titling templates. 

 

Use these templates to 
personalize your movie titles and credits.

 

O

 

Stock clips.

 

 These include photos, video 
footage, and audio clips that are licensed for 
your use.

 

O

 

Sample QuickTime movies

 

. These include a 
music video and a public service announcement 
that were created by video professionals with 
Adobe Premiere.

 

O

 

Online documentation

 

. The 

 

Adobe Premiere 
User Guid

 

e is included in the Portable Docu-
ment Format (PDF)

 

 

 

so it can be read on-screen 
using Adobe Acrobat software.

 

O

 

Adobe Acrobat Reader software

 

. This software 
lets you view the online documentation with the 
original graphics, type, and layout intact. You 
can find the Acrobat Reader software in the 
Acroread directory. For installation instruc-
tions, see the Acroread file in the subdirectory.

 

O

 

Additional information.

 

 You can find informa-
tion on other Adobe Systems and third-party 
applications that you can use to enhance your 
Adobe Premiere movies.

 

Using the Adobe Premiere Deluxe CD-ROM

 

The Deluxe CD-ROM has an interactive shell 
that makes it easy to browse the contents of the 
disc. However, before you can view the tutorial 
movies, you need QuickTime for Windows 
installed. If you do not have QuickTime for 
Windows already installed, you can install 
Adobe Premiere, which also installs QuickTime 
for Windows. For further instructions on 
installing Adobe Premiere, see “Installing the 
Adobe Premiere Program” on page 3. 

 

To use the Adobe Premiere Deluxe CD-ROM:

 

1

 

Insert the Adobe Premiere Deluxe CD-ROM 
into your CD-ROM drive.

 

2

 

Start Windows, if it is not already running.
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3

 

3

 

Choose one of two options:

 

O

 

If you are using Windows 3.1 or Windows NT, 
choose File > Run from the Program Manager, 
type 

 

d:deluxecd.exe

 

 (where d: is the CD-ROM 
drive indicator), and click OK. 

 

O

 

If you are using Windows 95, choose Start > 
Run, type 

 

d:deluxecd.exe

 

,

 

 

 

and click OK.

 

4

 

Follow the on-screen instructions.

 

REGISTRATION

 

We are confident you will find that the Adobe 
Premiere program greatly increases your 
productivity. So that we can continue to provide 
you with the highest quality software, offer 
technical support, and keep you informed about 
new Adobe Premiere software developments, 
please register your copy by using the online 
registration software provided or return 
the enclosed warranty registration card. The 
online registration process installs files, which 
can later be deleted, onto your hard drive 
(c:\premiere\regfiles). 

 

ABOUT ADOBE PRODUCTS AND SERVICES

 

For more information about Adobe products 
and services, you can use a variety of online 
services:

 

O

 

Forums on America Online and 
CompuServe

 



 

. Forums and availability 
may vary by country.

 

O

 

The Adobe Systems Incorporated Home 
Page on the World Wide Web. Use the 
Uniform Resource Locator (URL) 
http://www.adobe.com. 

 

O

 

Adobe’s own technical support bulletin-
board system. Call 206-623-6984. 

 

INSTALLING THE ADOBE PREMIERE 
PROGRAM

 

When you install Adobe Premiere from the 
Deluxe CD-ROM, the installer determines 
which version of Windows you are using and 
installs the appropriate version of Adobe 
Premiere. Version 4.2 of Adobe Premiere 
requires the 32-bit operating environment of 
Windows 95 or Windows NT. Version 4.0 of 
Adobe Premiere is for use with Windows 3.1.

 

To install the Adobe Premiere program:

 

1

 

Start Windows, if you have not already done 
so, and insert the Adobe Premiere Deluxe disc 
into your CD-ROM drive.

 

2

 

Choose one of the following options:

 

O

 

If you are using Windows 3.1 or Windows NT, 
choose Run from the Program Manager File 
menu, type 

 

d:\

 

premiere\install.exe

 

 (where d: is 
the CD-ROM drive indicator), and click OK. 

 

O

 

If you are using Windows 95, choose Start > 
Run, type 

 

d:\premiere\install.exe

 

,

 

 

 

and click 
OK.

 

3

 

Follow the on-screen instructions, entering 
your name, company, and the serial number. 
Your serial number is located on the registration 
card, on the Read This First Card, and on the 
first page of the 

 

Adobe Premiere User Guide

 

. 

 

Important:

 

 If you’re upgrading from version 1.1 
or 4.x, use the serial number of that version, 
located on the first page of your original 

 

Adobe 
Premiere User Guide

 

. If you are upgrading from 
the LE version, use the new serial number included 
with this version.
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4

 

Click OK or Next. When the User Informa-
tion Confirmation Screen appears, click OK 
to continue.

 

5

 

Choose one of two options:

 

O

 

Accept the default target drive and directory 
that is displayed. 

 

O

 

Use the list boxes to select a directory and 
a drive for the installation, typing a new drive 
and directory. 

 

Important:

 

 If you’re upgrading from an earlier 
version, the installer overwrites the directory 
containing the previous Adobe Premiere version. 
To keep the earlier version installed, change the 
default subdirectory (\Premiere) to another 
directory (e.g., to c:\Prem42).

 

6

 

Choose the installation setup you prefer: 
Typical for the most common options; Compact 
for the minimum required options; or Custom 
to choose the options you want to install. 

 

7

 

Create a program folder or select an existing 
program folder for the application icon.

 

8

 

Click OK or Next to begin the installation, 
and follow the on-screen instructions. A mes-
sage appears when installation is complete. 

 

9

 

To register the application online, leave the 
Electronic Registration option selected, and 
then follow the on-screen instructions.

If you choose to delay registering the applica-
tion, Adobe Premiere will remind you later to 
register the program. 

 

Note:

 

 Electronic registration is not available for 
Premiere 4.0.

 

10

 

If prompted, close all other applications so 
that the installer can restart Windows.

 

STARTING ADOBE PREMIERE

 

To use Adobe Premiere, you must have installed 
the files from the Deluxe CD-ROM disc 
onto your hard drive. You cannot run Adobe 
Premiere from your CD-ROM drive. For
installation instructions, see “Installing the
Adobe Premiere program” on page 3.

 

To start Adobe Premiere from Windows:

 

Choose one of two options:

 

O

 

From the Windows Program Manager, open 
the Adobe group. Double-click the Adobe 
Premiere program icon. 

 

O

 

From the Windows 95 Start > Programs 
menu, choose Adobe Premiere 4.2.

 

UNINSTALLING ADOBE PREMIERE 4.2

 

If you are using Windows 95, the Uninstall 
command lets you quickly remove all folders or 
directories and files that the Adobe Premiere 4.2 
installer installed on your hard disk, without 
affecting your Adobe Premiere projects or mov-
ies, or any other file added after installation. 
After uninstalling Adobe Premiere 4.2, you 
can manually remove files you’ve added after 
the initial installation. 

 

Note:

 

 Adobe Premiere 4.0 does not have an unin-
stall program. To uninstall Adobe Premiere 4.0, 
you must manually remove the files.

 

To uninstall Adobe Premiere 4.2: 

 

1

 

Exit Adobe Premiere.

 

2

 

Choose Start > Settings > Control Panel. 
Double-click the Add/Remove Programs 
option, and select Adobe Premiere in the list 
box. Click Add/Remove.

 

3

 

Follow the on-screen instructions until the 
Adobe Premiere program files are removed.

 

4

 

Restart Windows.
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dobe Premiere 4.2 now supports 
Windows 95 and Windows NT. 
This version of Adobe Premiere also 

supports Adobe Photoshop

 

™

 

 3.0 filters, the Intel 
Indeo Interactive software codec, and includes 
special processing options for optimizing mov-
ies for playback from CD-ROM. For informa-
tion on new features and enhancements added 
to version 4.0, see “What’s New in Adobe 
Premiere 4.0” on page 9. For information on 
Indeo Interactive, see its Read Me file.

 

WINDOWS 95 AND WINDOWS NT SUPPORT

 

Adobe Premiere 4.2 is a 32-bit application that 
supports the 32-bit operating environments 
of Windows 95 and Windows NT. This 32-bit 
support enhances the performance of Adobe 
Premiere when used with either of these operat-
ing systems. Windows NT provides additional 
performance improvements since all of its video 
components are 32-bit, unlike Windows 95, 
which uses 16-bit video components.

Other Windows 95 features that Adobe Premiere 
supports include the following:

 

O

 

Filenames using up to 255 characters

 

O

 

The look and feel of Windows 95 dialog boxes

 

O

 

Right mouse button control of all windows

Right-clicking the background of the applica-
tion window displays current function key 
assignments. Choose Function Keys from this 
menu to add additional assignments or change 
existing ones.

Additionally, positioning the pointer over a tool 
or button displays its name and any associated 
shortcut key.

 

SPECIAL PROCESSING FEATURES FOR 
OPTIMIZING CD-ROM MOVIES

 

New special processing features enable you to 
optimize movies for playback from low data-
rate environments, such as CD-ROM. These 
options give you greater control over your final 
movies by enabling you to crop the entire movie, 
add a gamma-correction filter, add a noise 
reduction filter, deinterlace your movie, and 
optimize movie resizing. You can also optimize a 
movie’s interactive playback by setting key 
frames at edit points and at markers in the Con-
struction window. Adobe Premiere previews all 
of these options, along with any other filters and 
transitions, as you set them. 

The key frame options are located in the 
Compression Settings dialog box (choose 
Make > Compression, or click Compression 
in the Make Movie dialog box). To set the other 
special processing options, click Settings in the 
Compression Settings dialog box. For more 
information on setting other compression 
options, see “Selecting Compression Options” 
in Chapter 8 of your 

 

Adobe Premiere User Guide.

 

 

 

Using markers or edits to specify 
key frames

 

Instead of, or in addition to, setting a regulated 
key frame rate, you can use markers in the time 
ruler and edits in the Construction window to 
specify key frames. Specifying key frames can be 
useful when authoring an interactive title 
because it enables you to identify frames from 
which you can start or stop playback, depending 
on user input. You may also want to use either 
option if you use infrequent key framing and 
you want to improve random-access playback.

 

What’s New in Adobe Premiere 

 

4.2

 

A
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To ensure that only the frames you specify are 
key frames—with the exception of the first 
frame, which is always a key frame—set a key 
frame rate that is greater than the total number 
of frames in your movie. For example, if your 
movie is 20 seconds long at 15 fps, set the Key 
Frame Rate higher than 300. 

 

Note:

 

 Some codecs automatically create key 
frames when they detect sufficient difference 
between frames. This can result in more key frames 
than expected.

 

Noise reduction

 

The Noise Reduction feature reduces grain or 
noise by averaging pixels to reduce the effect of 
high-contrast pixels, creating a blurred or soft-
ened image. Reducing the overall level of noise 
in a movie can also help the codec improve com-
pression, thereby achieving lower data rates. 

You have three quality options: Blur, Gaussian 
Blur, and Median. Blur is the most subtle option, 
smoothing significant color transitions by aver-
aging the pixels next to the hard edges of defined 
lines and shaded areas. Gaussian Blur is stronger 
than the Blur option and can produce a hazy 
effect. Median blurs an image more than the 
other two options, but the Median option is 
designed to preserve the edges of objects. For 
example, if you use the Median option on a 
close-up, you’ll lose detail in the broader areas of 
the face, such as wrinkles in the cheeks and fore-
head, but retain detail where features create hard 
edges, such as the eyes and mouth. 

 

Gamma correction

 

Use the Gamma option when you want to 
lighten or darken an entire movie. Using this 
option can be a more convenient alternative to 
using the Gamma filter on all your clips. The 
Gamma option lightens or darkens movies by 

changing the brightness levels of the midtones 
(the middle-gray levels) while leaving the black 
and white areas unaffected. 

 

Better resizing

 

If your movie’s frame size is smaller than your 
clip size, you can optimize the movie by using 
the Better Resize option. With this option 
selected, Adobe Premiere resizes the movie using 
a high-quality interpolation method. (It is the 
same method as found in Adobe After Effects

 

™

 

.) 
If you don’t use this option, the codec you have 
selected will resize the movie, most likely with 
poorer results. 

Deinterlacing

Use the Deinterlace option if you have full-
frame video source clips (640 x 480 pixels or 
larger) and if the movie you are creating is 
smaller than 640 x 480 pixels, especially if you 
are creating movies for CD-ROM playback and 
are using Cinepak™. Deinterlacing removes the 
secondary field in each frame and doubles the 
lines of the dominant field.

Cropping movies

Now you can crop unwanted pixels from the 
edges of your entire movie and either resize the 
movie or scale the image to fit the original frame 
size (as specified with the Size option). The 
cropping feature crops the entire movie. If you 
want to crop just a clip in the movie, use the 
Crop or Image Pan filters, or the Zoom option 
with the Motion command. 

To crop a movie:

1 From the Special Processing dialog box, 
choose one of two options:

O Enter the number of pixels you want to crop 
from each edge in the respective text boxes.
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O Resize the cropping box by dragging one of 
the square handles at any corner. To constrain 
the cropping box to a 4:3 aspect ratio, hold down 
the Shift key as you drag any handle. To crop in 
multiples of 4 pixels, hold down the Control key 
as you drag a handle. 

Important: If you are using Cinepak or Indeo, 
crop in multiples of 4 for the best results. 

2 Drag the slider bar to step through the movie 
and preview how your crop settings affect indi-
vidual frames. 

3 If you want to scale the cropped image to the 
movie’s frame size, select the Resize to option. 
Keep in mind that scaling the movie can distort 
the image.

NEW FILTERS

Adobe Premiere 4.2 includes several new filters.

Camera View filter

The Camera View filter distorts a clip by simu-
lating a camera on the surface of a sphere view-
ing the clip at the sphere’s center. By controlling 
the location of the camera on the sphere’s sur-
face, you distort the shape of the clip. You can 
make the camera appear to move around the 
sphere by applying the filter over time. See 
“Changing Filters Over Time” in Chapter 6 of 
the Adobe Premiere User Guide. You can set the 
camera’s location using the following controls:

Longitude moves the camera horizontally. The 
effect makes the clip appear to be flipping hori-
zontally. Longitude is measured in degrees from 
0 to 360.

Latitude moves the camera vertically. The effect 
makes the clip appear to be flipping vertically. 
Latitude is measured in degrees from 0 to 180. 
The origin is at the top of the sphere.

Roll rolls the camera, having the effect of rotat-
ing the clip.

Focal Length changes the focal length of the 
camera lens. Shorter focal lengths provide wider 
views, whereas longer focal lengths provide nar-
rower, but closer views.

Distance sets the distance the camera is from the 
center of the sphere. The default value is 1. 

Zoom enlarges or reduces the view of the clip.

Lens Distortion filter

The Lens Distortion filter distorts a clip by dis-
torting a simulated lens through which the clip 
is viewed. By experimenting with the settings in 
this dialog box, you can create interesting and 
unusual effects. You can distort the simulated 
lens using the following controls:

Curvature distorts the curvature of the lens, 
thereby distorting the image. Negative values 
make the image concave; positive values make 
the image convex. 

Vertical Decentering and Horizontal Decenter-
ing displace the focal point of the lens, making 
the image bend and smear. At extreme mini-
mum and maximum settings, the image wraps 
in on itself.

Vertical Prism FX and Horizontal Prism FX 
create effects similar to decentering, except that 
at extreme values the image will not wrap in 
on itself.

Mosaic filter

The Mosaic filter divides the image into a grid of 
squares and makes each square the average color 
of all the colors in the square. You can make the 
effect of the Mosaic filter gradually increase or 
decrease as the clip plays by adjusting the Start 
and End controls in the filter’s dialog box.
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Strobe filter

The Strobe filter simulates a stroboscopic effect, 
or strobe light, by hiding frames at a regulated 
rate as the clip plays. You can set the regularity of 
the effect by specifying the number of visible 
and hidden frames. When the clip is hidden, the 
frame is filled with a selectable color and the 
alpha channel is empty. This filter is useful for 
creating flashing titles keyed over other images.

Swap Left/Right filter

The Swap Left and Right filter transposes the left 
and right channels of a clip. This is useful if you 
accidentally recorded the channels in reverse 
and need to correct it to produce the movie.

BATCH COMPILING MOVIES

Now you can compile more than one movie at a 
time. The Batch Movie Maker uses the project 
and compression options you specify for each 
movie being compiled. You can create and save 
multiple batch lists for easy recompiling of 
groups of projects.

To batch compile movies:

1 Specify the project and compression options 
for each project you want to include in the 
batch list.

2 Choose File > Tools > Batch Movie Maker.

3 To add files to the batch list, click Add. Use
the Open dialog box that appears to select the 
projects you want to compile.

4 To change the name of a compiled movie, 
select the project in the batch list and click 
Target.

5 To make sure that all files associated with 
a project are still in their proper locations, select 
the project in the list and click Check. If 
files have been moved, batch processing will 
be interrupted.

6 To compile the projects in a previously saved 
batch list, click Load. 

7 To save the batch list after adding all of the 
files you want to compile, click Save.

8 Click Make to begin the compiling process.

BACKGROUND MOVIE COMPILING

Adobe Premiere 4.2 allows background movie 
compiling, enabling you to use the computer for 
other tasks while a movie or preview renders. To 
compile a movie in the background, click on the 
minimize button in the upper-right corner of 
the progress bar window. When a movie has 
been compiled, or an error occurs, Adobe Pre-
miere returns to the foreground.

EDITING 

O You can split all the unlocked tracks in the 
Construction window at once by using the new 
Razor at Edit Line command on the Edit menu.

O Now you can mark in and out points with 
function keys. New Mark In and Mark Out 
commands have been added to the Clip menu. 
You can assign these commands to function keys 
by selecting File > Preferences > Function Keys. 

NEW FRAME SIZE LIMITS

Now you can import and output smaller and 
larger movies. The smallest frame size you can 
work with is now 32 x 32 pixels, and the largest 
frame size is 4000 x 4000 pixels.

ASPECT FILL COLOR

Previously, when you used the Maintain Aspect 
Ratio command on a clip, Adobe Premiere filled 
the border around the clip in black. Now you 
can use the Aspect Fill Color command on the 
Clip menu to select a different color for this area.
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ersion 4.0 of Adobe Premiere adds 
support that video and multimedia 
professionals have been asking for,

including frame-accurate device control, batch 
capture and processing, support for 29.97 frame 
rates (true NTSC video), Edit Decision Lists, 
a Trimming window, titling, motion control, 
up to 99 video and 99 audio tracks, enhanced 
previewing, new filters and transitions, and 
support for custom filters and transitions.

IMPROVED EDITING FEATURES

New editing tools and an improved interface 
make Adobe Premiere easier to use for editing 
your movies.

New Trimming window

The new Trimming window expands editing 
capabilities by putting all the controls in an easy-
to-use window. You use the Trimming window 
to perform ripple and rolling edits on the in 
points and out points of adjacent clips. The 
Construction window dynamically shows the 
changes to both clips and how those changes 
affect clips in other unlocked tracks.

O In a ripple edit, the frames on both sides of 
a cut between clips are displayed side by side. 
You can change the cut point by adding or 
subtracting frames from either clip, by clicking 
on buttons that appear under each frame, or 
by entering a numerical offset.

O In a rolling edit, you simply place the 
pointer between the two frames and drag in 
either direction.

Improved Construction window

Editing in the Construction window has 
been improved in version 4.0.

O The Construction window can now 
display up to 99 video and 99 audio tracks, 
which enables you to create sophisticated 
composited effects.

O You can now perform an automatic insert edit 
by dragging a clip over any edit point. Clips on 
all unlocked tracks shift over to make room for 
the new clip.

O A new Ripple Delete command automatically 
closes the gap when you use it to delete a clip. 
You can also use the command to close up blank 
space in the timeline.

O A new extended tools pop-up menu simplifies 
the selection of many tools that you formerly 
selected using keyboard shortcuts. Tools in 
the extended tools pop-up menu include link 
override, soft link, ripple and rolling edit, and 
range selection.

O The new range select tool lets you select a 
group of items and perform editing functions on 
the entire group. For example, you can apply 
filters to multiple clips or move multiple clips 
as a group.

O The new playback head and edit line help you 
select edit points in the Construction window 
for previewing and further editing.

What’s New in Adobe Premiere 4.0

V
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O Audio and video tracks can be linked, and 
tracks in the Construction window can be 
locked and unlocked to maintain video and 
audio synchronization during editing.

O A new virtual clips feature lets you treat any 
area on the timeline as a single clip so that you 
can apply other effects, such as motion settings 
or a transition, to a group of clips.

GREATER CREATIVE CONTROL

Adobe Premiere 4.0 offers new features that give 
you greater creative control of your movies.

Title window

The new Title window allows you to create titles 
and graphics for a movie. Title clips can be 
superimposed to create titles and credits that 
play over other clips. You can animate type by 
applying motion settings to title clips.

Custom transitions and filters

You can now create your own custom effects in a 
variety of ways. You can build custom transi-
tions using the Adobe Photoshop blend tools 
with the Gradient Wipe transition. You can also 
use the new Transition Factory and Filter Fac-
tory to write custom transitions and filters using 
mathematical image-processing expressions.

Many filters, including the Adobe Photoshop 
filters that ship with Premiere 4.0, can be varied 
over time. For example, you can apply the 
Crystallize filter in such a way that the clip 
becomes progressively distorted as it plays.

Motion control

A wide range of motion control settings are pro-
vided to animate and distort any clip along a 
specified motion path. Motion controls allow 
you to position points along the motion path 
with exact time locations relative to the clip itself 
or to the overall timeline of the project. You can 

also set acceleration and deceleration options 
for each key frame and show all points between 
key frames for more precise control of accelera-
tion and deceleration.

Improved compositing

Many new key types have been added, including 
a variety of matte and screen treatments such as 
track matting.

PROFESSIONAL FEATURES

Adobe Premiere 4.0 provides the features of 
high-end video editing systems on your PC.

Capture movies with device control

If you have a controllable tape deck, you can 
capture movies using a device controller. 
Capturing with device control allows you to 
control the tape deck from your computer, 
makes it easier to capture only the frames you 
need, and allows you to batch capture clips. 
Adobe Premiere 4.0 supports V-LAN and 
ARTI networks as well as Media Command 
Interface (MCI) drivers, such as VISCA. 
Others can be added as plug-ins.

Support for Edit Decision Lists

You can now create an Edit Decision List 
from your compiled movies for online editing 
in a production studio. Adobe Premiere 4.0 
supports the CMX 3400, CMX 3600, Grass 
Valley, and Sony® BVE formats; additional
formats can be integrated with Adobe Premiere 
as plug-in extensions.

Support for true NTSC video editing

You can now capture Video for Windows movies 
at exactly 29.97 frames per second (fps). In 
addition, you can work in the Construction and 
Clip windows at 29.97 fps, as well as compile 
Video for Windows and QuickTime movies 
at 29.97 fps.
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Support for 60-field processing

You can now export filmstrips at 60 fps and con-
vert 60-frame animations into 60 fields of video. 
Field interpolation is used when changing 
speeds and when playing video in reverse.

PERFORMANCE ENHANCEMENTS

Performance enhancements and new utilities 
save you time in Adobe Premiere 4.0.

Dynamic previewing

You can now preview edits without compiling 
transitions and effects. An indicator appears in 
the clip to remind you that an effect still needs to 
be compiled. You can use this new previewing 
system in the new Controller window, as well as 
in the Construction and Trimming windows.

Full-speed previewing

Once you have compiled transitions and effects 
for previewing, you can save the preview so that 
you don’t have to compile the effects again to 
view them.

Function keys for frequently used 
commands

You can use function keys to quickly access 
the commands you use most often. You can
use the default function key mappings or easily 
create your own.

AVI movie analysis

The integrated Movie Analyzer provides valu-
able information about your movies, including 
file size, number and type of tracks, duration of 
tracks, frame rate, frame size, compressor, and a 
graph of the data rate over time.

Project presets

Like style sheets, project presets store combina-
tions of settings for common tasks such as creat-
ing videos or making CD-ROM movies. You can 
modify the existing presets or add your own. 
Project presets control the movie frame rate, 
compression method, preview options, output 
options, and project time base.

IMPROVED INTERFACE

Other improvements to the interface make it 
easier to view edits and to manage files.

Controller window

You can now view areas of the Construction 
window using a special floating window called 
the Controller. The Controller window has all of 
the controls found in the Clip window, includ-
ing jog, play, and set marker, as well as a SMPTE 
timecode display that shows the current loca-
tion. With the new dynamic previewing, you can 
play back previews with no delay.

Improved Project window and 
file management

The Project window can now contain folders 
and subfolders to help you better organize and 
display clips.

When replacing low-resolution clips with high-
resolution clips for final editing, you can use the 
Project Trimmer to recapture only the portion 
of each clip that has actually been used in the 
project. Doing so can save tremendous amounts 
of hard disk space, especially if you work with 
very large source clips.
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program’s performance is the amount 
of time it takes the application to 
complete certain operations, such as

opening a file, processing effects, or redrawing 
the screen after you edit an image. In part, 
performance is determined by the type of com-
puter and amount of memory you’re using. 
Other factors that can dramatically impact 
Adobe Premiere performance include your 
software setup, your use of virtual memory, and 
the size and complexity of your files.

USING WINDOWS VIRTUAL MEMORY

Windows virtual memory swaps active applica-
tion programs to a hard disk when there is not 
enough RAM to hold them all simultaneously. 
Virtual memory is disk space used for storing 
data and performing computations on files dur-
ing a work session when RAM is insufficient.

If you have less than 20 MB of installed RAM, 
you should probably not set the virtual memory 
to an amount greater than twice your RAM, 
because doing so will degrade the performance 
of Windows and other Windows applications. 
Instead, you should keep as much hard disk 
space available as possible so that the Adobe 
Premiere program can use it as needed. If your 
system has more than 20 MB of RAM, you may 
want to turn off virtual memory because you 
will probably not need it.

MAXIMIZING PERFORMANCE

The best way to improve performance is to 
increase the amount of RAM installed on your 
system. For full-screen editing, you should have 
at least 16 MB of RAM.

If you do not want to purchase additional 
RAM, you can maximize the program’s 
performance in other ways, as described in 
the following sections.

Limit the disk cache size

You can limit the size of the disk cache by adjust-
ing the memory allocation of SMARTDrive, 
the default Windows disk caching program. 
SMARTDrive reserves RAM to temporarily 
store data that is frequently accessed from your 
hard disk drive. On 8 MB systems, the default 
disk cache size is 2 MB. You can allocate some 
of this RAM to Adobe Premiere by decreasing 
the disk cache size to a minimum of 512K. 
For more information on adjusting the size of 
the disk cache using SMARTDrive, see your 
Windows documentation.

Start Adobe Premiere first

Start Adobe Premiere before starting other Win-
dows applications, or run the program by itself. 
If other applications are already running under 
Windows when you start Adobe Premiere, they 
may have allocated memory for their own use 
that Adobe Premiere cannot access. If possible, 
run Adobe Premiere by itself. Otherwise, start 
Adobe Premiere immediately after starting Win-
dows, and then start any other applications.

Remove StartUp items

Check the LOAD and RUN lines in your system’s 
win.ini file and check your StartUp group for 
program items that load automatically when 
Windows starts. Delete any unnecessary StartUp 
items to free memory for Adobe Premiere.

Improving Performance

A
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Disable network software

When running Adobe Premiere with full-
motion movies, you should turn off any net-
work software. Network software requires a con-
siderable number of CPU cycles, so it could 
cause frames to drop during the recording and 
playback of movies.

OPTIMIZING YOUR HARD DISK

To improve disk performance, you should 
optimize your hard disk.

Defragment your hard disk

Use a defragmenting utility to optimize and 
defragment your hard disk as often as necessary 
to keep it efficient. Recording to a fragmented 
disk could reduce the capture frame rate or 
cause frames to be dropped. A fragmented 
disk will also cause opening and saving files 
to take longer.

Delete unneeded preview files

Whenever you preview a movie, Adobe Premiere 
saves the rendered (compiled) special effects in a 
temporary subdirectory in the same directory 
that holds your project. For example, if you 
are working on a project named circus.ppj, the 
preview files are saved in a directory named 
circus.tmp. In general, you should not remove 
the preview files until you have finished a project 
because Adobe Premiere can reuse preview files 
rather than recompiling them. However, if you 
are running out of disk space, you can remove 
old preview files from the temporary directories. 

You can delete any compiled preview files by 
using the Windows File Manager to locate and 
delete files. You can delete the compiled preview 
files for a current project from within Adobe 
Premiere by pressing Shift+Ctrl+Alt and click-
ing the gray bar above the time ruler.

SPEEDING UP PREVIEW COMPILATION

You can decrease the time spent compiling 
previews in one of two ways.

Use a faster compressor for previews

Even if you will use the Cinepak or Indeo com-
pressors for your final movie, you can use a 
faster compressor to create previews. Because it 
compresses less, the Microsoft Video 1 compres-
sor is considerably faster than either Cinepak or 
Indeo. You could use the Video 1 compressor to 
build previews to test your editing decisions, 
then use the Cinepak or Indeo compressor for 
the final movie.

If you change compressors, Adobe Premiere will 
not be able to use precompiled previews when it 
builds the final movie. Depending on your 
project, the time savings during previewing may 
be worth the extra time spent during the final 
compilation.

Keep project settings the same as for the 
source clips

If you are using source clips that have already 
been compressed and are already at the frame 
size, frame rate, and color depth of the final 
movie, you can reduce preview compiling times 
by making sure that Adobe Premiere isn’t 
recompressing the clips. If the project settings 
match the source clip settings, Adobe Premiere 
only needs to compile effects, such as transi-
tions, and new material. Use Adobe Premiere’s 
Movie Analysis feature (File > Tools > Movie 
Analysis) to check a movie’s settings.

To avoid recompression, all of the following set-
tings must be identical for the source clips and 
project: compressor, frame rate, frame size, key 
frame rate, and color depth. For more informa-
tion, see “Selecting Compression Settings” in 
Chapter 8 of the Adobe Premiere User Guide.
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his section contains troubleshooting 
tips for capturing video. Because of the 
variety of equipment you use to

capture video, including video digitizing boards, 
sound boards, device controllers, and source 
video decks, tracing the source of problems 
during capture can be difficult. This section 
provides general guidelines you can use to locate 
and solve capture problems.

You have no sound or video

Check your equipment and connections
as follows:

O Check all of your equipment cables. Make 
sure that the video out ports of your video 
source are connected to the video in ports on 
your capture board.

O Make sure your sound and video boards are 
installed correctly, and make sure the IRQ and 
DMA settings for the boards are not conflicting 
with another device. Consult your video and 
audio board documentation for information on 
changing these settings.

You have video but no sound

Check your source deck and speakers as follows:

O Check the source for a level control and 
turn it up. 

O Some sound boards have a mixer program 
or control panel that controls levels and inputs. 
Use the mixer to check the audio levels.

O If you’re using S-Video, make sure that you 
install separate sound cables. S-Video cables do 
not carry audio signals.

O Make sure you have speakers connected to the 
sound output port on your sound board. The 
built-in speaker on a PC cannot be used to play 
back sound from Adobe Premiere.

O Also make sure the Record Audio command 
in Adobe Premiere’s Capture menu is checked.

You have sound but no video

Make sure you have chosen the correct video 
source from within Adobe Premiere. To change 
the video source, choose Video Source from the 
Movie Capture menu and select the type of 
video source. If you are not sure which type 
of signal you are using, try selecting a different 
signal. For example, if Composite Video is 
selected, change it to S-Video.

The video picture is distorted

Check your source deck and videotape 
as follows:

O Make sure you have selected the correct video 
signal for your video source. To change the video 
signal type, choose Video Source from the 
Movie Capture menu and select the video signal 
format. The video signal formats are NTSC 
(used in the United States, Canada, and Japan), 
PAL (used in the United Kingdom, Australia, 
and Germany), and SECAM (used in France).

O Replace the video cable.

O Check your video source. Adjust the tracking 
control of the deck and clean the heads. If you’re 
still having problems, try a different deck.

O Check the quality of the source videotape. 
Play the tape and preview it on a monitor; tears 
or rolls that appear on the tape will also appear 
in the captured video.

Troubleshooting Tips for Video Capture

T
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Frames are dropped during capture

Check for data transfer bottlenecks as follows:

O If your capture board uses hardware compres-
sion, lower the quality setting of compression. 
By lowering the quality (and thus increasing the 
compression), you are decreasing the amount 
of data being written to your hard drive. You 
can change the compression quality by choosing 
Recording Settings from the Movie Capture 
window, and then clicking the Video Format 
button.

O If you don’t need to capture sound, turn it off 
by selecting Record Audio from the Movie 
Capture menu. Audio data can be a significant 
portion of the captured file; by turning off 
sound capture you allow more video data to be 
captured.

O Check the data rate of your hard drive to make 
sure it can accept the data rate required by your 
capture card.

O If you have a fast hard drive, check the data 
rate of the hard drive controller. The hard drive 
and its controller are often a bottleneck in the 
capture process. 

O Check the CPU speed of your computer.

O Use a preallocated capture file. You can set up 
a preallocated capture file by choosing Capture 
File from the Movie Capture menu. When you

use a preallocated capture file, you reduce seek 
time on the hard drive, which reduces the risk of 
dropped frames.

O Reduce the frame size or the frame rate of the 
captured movie. 

You are running out of disk space 
while capturing

Check your hard drive as follows:

O If you have more than one hard drive, make 
sure you are capturing to a drive with enough 
disk space on it. To change the drive, choose 
Preferences from the File menu, and then choose 
Scratch Disk.

O Defragment your hard drive using any defrag-
menting utility, such as Norton Utilities®.

You run out of memory the second time 
you capture

Some video capture drivers do not release 
the memory they’ve allocated when you stop 
capturing. To force video drivers to disconnect, 
choose Preferences from the File menu, then 
choose Video Capture. In the Driver Options 
dialog box, select the Always Disconnect 
Capture Driver option.

For more information on using this preference 
with specific video drivers, see the readme.txt file 
in the Adobe Premiere directory.
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he Adobe Premiere package includes 
Adobe Type Manager (ATM) software, 
which gives all your applications a 

smooth, high-quality display for Adobe Type 1 
fonts. (You must install ATM separately. You can 
install it from the interactive shell on the Deluxe 
CD-ROM, or by running its setup program 
found in the ATM folder. For instructions on 
using the interactive shell, see “Using the Adobe 
Premiere Deluxe CD-ROM” on page 2.)

The following sections describe how to use the 
ATM program options and provide information 
on printing Type 1 fonts on PCL and PostScript® 
printers. 

Note: ATM does not work with Windows NT.

USING THE ATM CONTROL PANEL

The ATM control panel lets you add and remove 
Type 1 fonts and select ATM options that can 
enhance your system’s performance.

To use the ATM control panel:

1 Open the Main program group in the 
Program Manager.

2 Double-click the ATM icon to open the 
ATM control panel. 

3 Select the desired ATM options, as follows:

O On/Off turns the ATM software on and off. 
When ATM is on, it displays Type 1 fonts on-
screen and prints them on both PostScript and 
non-PostScript printers. When ATM is off, only 
non-Type 1 fonts appear on-screen. Type 1 fonts 
print correctly on a PostScript printer if you 
have installed the fonts, but Windows substi-
tutes another font for screen display and for 
printing on a non-PostScript device.

O The Font Cache determines the amount of 
system memory used to temporarily store 
bitmap characters created by ATM. If you use 
many typeface styles or sizes in a work session or 
if your applications seem unusually slow when 
you scroll or change pages, your font cache may 
be too small. The default setting is 256K. 

O The Use Prebuilt or Resident Fonts option can 
help your applications display and print docu-
ments more quickly. This option tells the ATM 
software to use bitmap fonts that reside in 
Windows or to use fonts that reside in the 
printer or on a type cartridge if they are avail-
able. However, you might not want to use the 
prebuilt or resident fonts if your application 
supports auto-kerning (the ATM fonts will be 
kerned but the prebuilt and resident fonts won’t 
be) or if the prebuilt or resident fonts appear 
different from the selected font (e.g., the Courier 
font on-screen appears different from the 
printer’s built-in version).

O The Print ATM Fonts as Graphics option tells 
the ATM program to send fonts to the printer as 
graphic images and not to use downloadable 
fonts. This option may slightly increase printing 
time, but it is useful if your PCL printer (such as 
an HP LaserJet printer and various clones) does 

Using the ATM Program

T
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not support downloadable fonts, or if a docu-
ment with mixed text and graphics does not 
appear to print correctly. 

4 Add or remove fonts, as described in “Adding 
Type 1 Fonts” on this page and “Removing 
Type 1 Fonts” on page 18.

5 Click Exit.

6 Restart Windows for the changes to take 
effect. You do not need to restart Windows after 
adding or removing fonts.

When you upgrade ATM, your control panel set-
tings (such as font cache size and installed fonts) 
are preserved.

ADDING TYPE 1 FONTS

The ATM control panel lets you add Type 1 fonts 
for use with Windows applications. You can 
print these Type 1 fonts on PostScript and 
non-PostScript printers and use the fonts for 
a “what-you-see-is-what-you-get” (WYSIWYG) 
screen display. 

If you purchase additional Type 1 fonts in 
the future, you should use the ATM control 
panel to install them so that you can use the 
fonts on both PostScript and non-PostScript 
printers. Font installers provided with Type 1 
fonts typically install fonts only for use on 
PostScript printers.

When the ATM program installs fonts, it

O Copies the Type 1 font outline (PFB) files to a 
directory on your hard disk

O Copies the Type 1 font metrics (PFM) files to 
a directory on your hard disk

O Updates the Atm.ini file so that the fonts are 
available to ATM

O Updates the Win.ini file so that you can use 
the fonts with any PostScript printer that works 
with the Microsoft PostScript printer driver

Note: ATM does not update the Win.ini file if you 
are using a Compaq®, Hewlett-Packard, QMS®, or 
Adobe printer driver (rather than the Microsoft 
PostScript printer driver).

To add Type 1 fonts:

1 Double-click the ATM icon to open the ATM 
Control Panel.

2 Click Add.

3 Insert the fonts disk into the disk drive. 

4 Use the Directories list box to locate the 
desired fonts. (Font names appear in the 
Available Fonts list box.) Double-click the letter 
of the drive containing the fonts disk; double-
click to open any directory on that disk.

5 To copy the font filenames to the Atm.ini and 
Win.ini files without installing the fonts, select 
the Install without Copying Files option. (Usu-
ally this option is left unchecked.) This option is 
useful if you use a large number of fonts from a 
CD-ROM or network drive. 

6 To transfer the font to your PostScript printer 
automatically each time you print, select the 
Install as Autodownload box. (Usually, this 
option is left unchecked so that fonts are not 
transferred with every print job.) This option 
updates the Win.ini file. 

7 Select the names of the fonts you want to add, 
and then click Add. 

Installing the fonts copies the Type 1 font 
outline (.pfb) files and the Type 1 font metrics 
(.pfm) files to a directory (\Psfonts by default) 
on your hard disk, updates the Atm.ini file so 
that the fonts are available to ATM, and updates 
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the Win.ini file so that you can use the fonts with 
any PostScript printer that works with the 
Microsoft PostScript printer driver.

Note: ATM does not update the Win.ini file if you 
are using a Compaq, Hewlett-Packard, QMS, or 
Adobe printer driver (rather than the Microsoft 
PostScript printer driver).

8 Click Exit. The fonts are available for use in 
your applications.

REMOVING TYPE 1 FONTS

You use the ATM control panel to remove fonts. 
The control panel does not remove the fonts 
from your hard disk unless you instruct it to do 
so. Separately, you must remove the fonts’ corre-
sponding .pfm and .pfb files. 

To remove fonts from your system:

1 Open the ATM control panel.

2 Select the Type 1 fonts that you want to 
remove. 

3 Click Remove. The ATM confirmation dialog 
box appears for each selected font.

4 Click Yes to remove the font. To remove the 
remaining fonts without confirming each 
removal, check the No Confirmation to Remove 
Fonts option. To delete fonts from the disk, 
check the Delete Fonts from Disk option.

5 Click Exit. It is not necessary to restart 
Windows when adding or removing fonts.

6 For each Type 1 font that you remove, delete 
the corresponding .pfm and .pfb files from the 
directories in which you installed them. The 

default directory is \Psfonts.

PRINTING ON PCL PRINTERS

For optimal performance when using a PCL 
printer (such as an HP LaserJet or 100% com-
patible printer) to print Type 1 fonts, connect 
the printer to your computer through a parallel 
(LPT) port.

PRINTING ON POSTSCRIPT PRINTERS

Each time you print, any Type 1 fonts not 
built in to the PostScript printer are automati-
cally downloaded, or transferred, to the printer. 
You can speed printing by manually download-
ing frequently used fonts with a Type 1 font 
downloader. Manually downloaded fonts 
remain in printer memory between print jobs, 
so that each time you print, you save the time 
it takes to download the fonts.

REMOVING ATM FROM YOUR SYSTEM

In the rare instances when you want to remove 
the ATM program from your system, you should 
first remove the Type 1 fonts.

To remove ATM from your system:

1 Open the ATM control panel.

2 In the ATM control panel, select the Type 1 
fonts you want to remove, and click Remove. 
In the confirmation dialog box, click Yes to 
remove the font. To remove the remaining fonts 
without confirming each removal, check the 
No Confirmation to Remove Fonts option. To 
delete fonts from the disk, check the Delete 
Fonts from Disk option.

3 Back up the System.ini file in your 
\Windows directory.

4 Use Notepad or another text-editing 
accessory to open the System.ini file in your 
Windows directory.
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5 Replace the following two lines located in the 
boot section of the System.ini file: 

system.drv=atmsys.drv

atm.system.drv=system.drv

with this line:

system.drv=system.drv

The first two lines may vary on some systems. 
The replacement line, however, should be the 
same as that shown in step 5.

Note: If you are using an HP Vectra machine, the 
line should read

system.drv=hpsystem.drv

Note: See the Read Me file for more information 
on System.ini.

6 Save the System.ini file as a text file; if you use 
a word-processing program to change the file, 
save the file without any text formatting.

7 Quit Notepad or your word-processing 
program, and exit Windows.

8 Delete the Atm.dll, Atm16.dll, Atm32.dll, and 
Atmsys.drv files from your \Windows\System 
directory. (If you do not have a version of ATM 
earlier than 2.0, your system will not have the 
Atm.dll file.)

9 Delete the Atm.ini and Atmcntrl.exe files 
from your Windows directory.

10 Delete the .pfm and .pfb files from the direc-
tories in which you installed them. The default 

directory is \Psfonts.

11 Delete the Atmfonts.qlc file from the 
directory that contained the .pfb files.


